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BAB 3 

 

PEMBELAJARAN GEOMETRI 

DENGAN WINGEOM 2-DIM 

 

 

 

Setelah mempelajari bab 3 ini, diharapkan: 

1. Pembaca dapat menggunakan Program Wingeom 2-dim untuk 

pembelajaran untuk topik garis dan sudut. 

2. Pembaca dapat menggunakan Program Wingeom 2-dim untuk 

pembelajaran untuk topik segitiga dan segiempat. 

3. Pembaca dapat menggunakan Program Wingeom 2-dim untuk 

pembelajaran untuk topik lingkaran dan irisan kerucut. 
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Dalam pelaksanan kegiatan pembelajaran, ditinjau dari fasilitas yang ada, 

ada dua pendekatan yang dapat dilakukan, yaitu pendekatan kelas dan pendekatan 

laboratorium. Pendekatan kelas digunakan jika tidak cukup tersedianya komputer 

bagi siswa. Pendekatan ini cukup memerlukan satu komputer dengan dukungan 

viewer (proyektor untuk komputer). Guru dapat membuat presentasi materi 

pembelajaran yang menarik dan menantang, yang memperhatikan aspek visual , 

animasi yang menarik, sekuensial, dan pertanyaan-pertanyaan bagi siswa yang 

mendukung pemahaman konsep.  

Jika tersedia fasilitas komputer yang mencukupi (idealnya satu komputer 

untuk satu siswa), maka dapat dilakukan pendekatan laboratorium. Dalam 

pendekatan ini Guru menyusun lembar kerja dan lembar kegiatan bagi siswa. 

Lembar kegiatan siswa berisi serangkaian tugas/kegiatan yang harus dikerjakan 

siswa untuk mengkonstruksikan pengetahuan (menuju suatu konsep tertentu). 

Lembar kerja siswa secara umum berisi pertanyaan-pertanyaan atau latihan yang 

harus dikerjakan siswa untuk makin memantapkan konsep yang didapat. 

 Dalam bab ini akan diberikan beberapa contoh kegiatan pembelajaran 

dengan pendekatan laboratorium. Dengan memodifikasi yang diperlukan, ide 

untuk pendekatan laboratorium ini dapat digunakan untuk pendekatan kelas. 

Dalam contoh-contoh berikut siswa melakukan perintah dengan menggunakan 

program Wingeom-2dim. Gambar-gambar yang ditampilkan adalah contoh hasil 

yang diharapkan dalam pengerjaan siswa dan juga berfungsi untuk memberikan 

umpan balik siswa dengan pengerjaanya. Siswa juga diberikan pertanyaan-

pertanyaan dan jawaban contoh yang diharapkan dicetak miring. Untuk dapat 

mengerjakan kegiatan yang diberikan sebelumnya siswa diberikan pengenalan 

pengoperasian program Wingeom. 
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3.1 Pembelajaran Garis dan Sudut 

 

3.1.1 Sudut pada Garis-garis Sejajar yang dipotong sebuah Garis 

 

1. Bukalah program Wingeom-2dim.  

2. Klik Btns > Segments, lalu dengan mengklik kanan mouse buatlah dua titik A 

dan B.  Kemudian gunakan bagian kiri mouse untuk menggambar AB . 

Sesudah itu klik kanan titik C dan D di atas (pada) AB  dan titik E di sebarang 

tempat di luar garis tersebut. Gambarlah  CE . 

 

 

 

3. Klik Line > Parallels, lalu ketik D dalam kotak through point dan CE dalam 

kotak parallel to, lalu klik tombol draw. Tampak bahwa DF  sejajar dengan 

CE . Klik kanan titik G di atas (pada) CE  dan titik H di atas DF (manfaatkan 

cara seperti pada langkah ke-2 di atas). 

4. Klik Other > Autoextend, untuk memungkinkan titik-titik tampak pada 

perpanjangan ruas garis-ruas garis, terutama untuk permintaan sesudahnya. 
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Tempatkan mouse pada Btns > Drag vertices dan gunakan tombol bagian kiri 

mouse untuk mendorong titik G sedemikian sehingga titik G tidak terletak 

pada sisi yang sama dengan titik E di AB . Ulangilah proses tersebut untuk 

titik H dan F. 

 

 

Perhatikan apa yang terjadi ketika engkau mendorong titik C dan D sepanjang 

AB  atau apa yang terjadi ketika engkau menggeser titik E di sekitar 

layar/tampilan. 

Hasil pengamatan: 

• Ketika titik C digeser sepanjang AB , ternyata : EG  bergeser di 

sepanjang AB  dengan titik E sebagai tumpuan/porosnya. Sementara itu 

FH selalu bergerak sejajar mengikuti EG  dengan titik D sebagai titik 

tumpuan pergerakan FH  

• Ketika titik D digeser sepanjang AB , ternyata : FH  bergerak sepanjang 

AB  dengan titik D sebagai pusatnya, akan tetapi tidak sekaligus diikuti 

dengan pergerakan EG  ( EG  tetap pada posisinya di AB ) 
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• Ketika E digeser sekitar layar/tampilan, ternyata : EG  bergeser dengan 

titik E sebagai pusatnya dan FH turut bergerak sejajar dengan EG . 

Selain itu, panjang EG  dan FH akan bertambah jika titik E digeser 

menjauhi AB  dan berkurang apabila titik E digeser mendekati AB  

5. Klik  Meas, ketiklah BCE∠  dan tekan Enter. 

Carilah dua sudut dalam gambar yang kelihatannya memiliki ukuran yang 

sama (<CDF dan <ADH), lalu gunakan fasilitas Meas untuk memeriksa 

dugaanmu. 

6. Periksa (dengan Meas) ukuran dari .CDH∠ Bagaimana besar sudut tersebut 

jika dikaitkan dengan ukuran dari BCE∠ ? (Jumlah besar 

sudut CDH∠ ditambah dengan besar sudut BCE∠  sama dengan 180
0
). 

 

 

 

Apakah prediksimu tetap benar ketika gambar tersebut diubah dengan 

menggeser titik-titik di sekitarnya? (Ya, bila titik-titik pada gambar awal digeser 

hingga bertukar posisi, meski besar sudut masing-masing dapat berbeda tetapi 

jumlah besar sudut keduanya tetap 180 derajat. Sebagai bandingannya dapat 

diperlihatkan dengan tampilan di bawah ini). 
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7. Rangkumlah penemuanmu tentang kedelapan sudut yang dibentuk ketika 

sepasang garis sejajar dipotong sebuah garis lurus. 

• <BCE dan <CDF,<ECD dan <FDA, <GCD dan <HAD, <BCG dan 

<HDC merupakan sudut-sudut sehadap. Berdasarkan ukuran sudut-

sudut sehadap tersebut  disimpulkan bahwa jika dua buah garis 

sejajar dipotong oleh garis lain maka sudut-sudut sehadapnya sama 

besar. 

• <ECD dan <HDC, <GCD dan <CDF merupakan sudut-sudut 

berseberangan dalam. Berdasarkan ukuran sudut-sudut 

berseberangan dalam tersebut disimpulkan bahwa jika dua buah garis 

sejajar dipotong oleh garis lain maka sudut-sudut yang berseberangan 

dalam adalah sama besar. 

• <BCG dan <FDA, <BCE dan <HAD merupakan sudut-sudut 

berseberangan luar. Berdasarkan ukuran sudut-sudut berseberangan 

luar tersebut disimpulkan bahwa jika dua buah garis sejajar dipotong 

oleh garis lain maka sudut-sudut yang berseberangan luar adalah 

sama besar. 

• <ECD dan <CDF, <GCD dan <HDC merupakan sudut-sudut sepihak 

dalam. Jumlah besar <ECD dan <CDF = <GCD dan <HDC yakni 

180 derajat. Jika dua buah garis sejajar dipotong oleh garis lain maka 

jumlah setiap pasang sudut sepihak dalam adalah 180 derajat. 

•  <BCG dan <HAD, <BCE dan <FDA merupakan sudut-sudut sepihak 

luar. Jumlah besar <BCG dan <HAD = <BCE dan < FDA yakni 180 

derajat. Jika dua buah garis sejajar dipotong oleh garis lain maka 

jumlah setiap pasang sudut sepihak luar adalah 180 delapan puluh 

derajat. 
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3.1.2  Sudut Bagi 

 

1. Bukalah program Wingeom-2dim.  

2. Pilih Random > Triangle ABC dari menu Units. 

3. Gunakan menu Line membagi  sudut segitiga ABC.  

4. Pilih mode Btns/Segments, gunakan tombol kanan ke gambar untuk membuat 

titik E yang terletak antara garis BD yang membagi garis AC.  

5. Gunakan menu Edit untuk menghapus titik D 

 

 

 

6. Pilih Meas. Tulis di measurements BA, BC, AE/EC kemudian tekan enter 

setelah masing-masing penulisan sudut, kemudian keluar dari dialog. Salah 

satu dalam layar akan menunjukkan bahwa titik E adalah bukan titik tengah 

dari AC. 
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7. Ubah mouse ke mode Drag vertices, kemudian  pakai tombol kiri ke drag 

vertices dari segitiga ABC untuk mengubah-ubah segitiga ABC tersebut 

dalam layar. Pertama kali cobalah membuat rasio AE/EC = 1. Dari berbagai 

jenis yang terjadi apa yang benar antara BA dan BC? 

 

Untuk membuat ratio AE/EC = 1, maka besar BA = 5,24 dan BC = 4 

 

8. Kemudian coba temukan pengaturan untuk membuat panjang BA dua kali 

lebih panjang daripada BC. Ketika kamu menemukan hal tersebut, perhatikan 

besar dari AE/EC. 
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(Setelah membuat panjang BA dua kali lebih panjang daripada BC, misalnya 

BA = 5 maka nilai BC = 2,5 maka besar nilai dari AE/EC = 1.47 

Maka dari gambar didapat  bahwa (teorema): 

Jika dua sisi dari sebuah segitiga  tidak sama besar, maka sudut yang 

berhadapan akan tidak sama dan sudut yang lebih besar itu berhadapan 

dengan sisi yang lebih panjang.  

Jika dua sudut dalam segitiga tidak sama, maka sisi  yang berhadapan tidak 

sama besar dan sisi yang panjang berhadapan dengan sudut yang besar). 

9. Rumus dari pernyataan disebut Teorema Sudut Bagi. Hal itu akan 

menjelaskan lokasi dari titik sudut sisi berhadapan dalam segitiga. Buat 

pengukuran tambahan untuk menguatkan peryataan anda. 

10. Gunakan teorema untuk menghitung AE, dimana AB = 9, BC = 15, dan CA = 

12 (Jika AB = 9, BC = 15 maka AE/EC = 6) 

11. Hasilnya yang berupa angka tidak dapat membuktikan maupun menjelaskan.     

Salah satu jalan untuk memahaminya dari mana asal sudut bagi tersebut ialah 

mengikuti aturan sebagai berikut. Gunakan menu line untuk memperpanjang 
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CB dan menggambar garis parallel ke BE  menembus A. Karena  garis 

memotong BC  mungkin tidak jelas maka gunakan dialog Point > intersection 

> Line-line ke titik ( yang mungkin titik F, kecuali kamu bisa menggantikan 

langkah-langkah sebelumnya ). Kemudian tekan  Ctrl + W untuk membuat 

semuanya jelas. 

12. Gunakan Measure untuk menentukan besar < BAF dan < BFA dan jelaskan 

mengapa hasilnya sama. Gunakan Measure untuk menentukan besar BA dan 

BF dan jelaskan mengapa hasilnya sama. Gunakan Measure untuk 

menentukan besar BF/BC dan EA/EC dan jelaskan mengapa hasilnya selalu 

sama. (Teorema Hasil Bagi Sudut di atas). 
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3.2 Segitiga dan Segiempat 

 

3.2.1  Pencerminan pada Segitiga 

 

1. Bukalah program Wingeom-2dim. 

2. Buatlah garia AB dan segitiga CDE yang berada disebelah kanan garis AB, 

seperti pada gambar berikut. 

  

3. Klik Transform > Mirror, ketik CDE ke kotak vertices, dan lihat bahwa AB 

muncul di kotak mirror. Klik draw. Bayangan segitiga CDE yaitu segitiga 

C'D'E' seharusnya akan muncul. 

4. Gambarlah 'CC  dengan klik kiri pada mode segment, dan klik kanan untuk 

membuat label F pada perpotongan 'CC  dan AB . 

5. Segitiga CDE dan C'D'E' tentu saja kongruen, tapi perhatikan bahwa arah 

penamaan  titik berbeda. 
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6. Sebelum kamu membuat perhitungan (mengukur), perkirakan hubungan 

antara 'CC  dan  AB , antara 'DD  dan AB , dan antara 'EE  dan AB . 

Sekarang ubah mode mouse ke Drag Vertices dan gunakan tombol kiri untuk 

menggerakkan puncak (sudut) dari segitiga CDE ke sekitar layar. Perhatikan 

apa yang terjadi pada bayangan segitiga, dan apa yang terjadi pada  

penghubung 'CC . 

• Jika kita menggerakkan titik C maka, gambar segitiga CDE akan 

berubah dan  segitiga C'D'E'  juga akan berubah sesuai dengan bentuk 

gambar segitiga CDE dan 'CC  akan mengalami perubahan panjang. 

• Jika kita menggerakkan titik D maka 'CC  tidak akan mengalami 

perubahan, tetapi 'DD  akan mengalami perubahan panjang. 

• Jika kita menggerakkan titik E maka 'CC  tidak akan mengalami 

perubahan, tetapi 'EE  akan mengalami perubahan panjang. 

7. Jika kamu menduga bahwa dua buah bangun akan kongruen oleh 

pencerminan,  bagaimana kamu pastikan dugaanmu dan bagaimana membuat 

garis pencerminan (cermin itu)?   
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(Dengan memeriksa ukuran-ukuran yang bersesuaian untuk kedua segitiga 

tersebut, seperti pada gambar berikut) 

 

 

Langkah-langkah pembuatan garis pencerminan : 

1. Misalkan dua hasil pencerminan segitiga ABC adalah segitiga A’B’C’. 

Tarik garis yang menghubungkan C dengan C', B dengan B', dan A 

dengan A'. 

2. Tentukan titik tengah 'AA , 'BB , dan 'CC  dan beri nama D, E, F pada 

setiap perpotongannya, ketiga titik potong ini hendaknya segaris.  Buatlah 

garis yang melalui ketiga titik tersebut misalkan garis GH. Jika garis GH 

ini tegaklurus terhadap 'AA , 'BB , dan 'CC , maka garis GH merupakan 

sumbu pencerminan. 
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3.2.2  Titik Berat Luasan 

1. Bukalah program Wingeom-2dim.  

2. Klik Unit / Random / Triangle untuk membuat segi tiga ABC yang nampak 

di jendela. 

3. Tanda midpoints D dan E dari garis AB dan BC: klik point / on segmen, 

membuat AB, BC ke dalam kotak segmen, dan klik mark. 

4. Dengan mouse di Btns / Segmen mode, menggunakan tombol kiri untuk 

menggambar titik tengah AE dan CD. kemudian klik kanan pada titik F ke 

dalam persimpangan dari AE dan CD. 

5. Panjang dari FD dan FE digunakan untuk menunjuk titik G dan H berturut-

turut.( Dengan kata lain, kita ingin FD = DG dan FE = EH) untuk melakukan 

ini, klik point / on segmen ( bisa menggunakan langkah 2). Kemudian ketik 

garis FD, FE ke dalam kotak segmen, masukkan 2 titik koordinat ke dalam 

kotak, dan klik mark. Dari langkah ini terlihat gambar yang ada di bawah. 
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6. Klik Measure, dan kitik garis AF / FE dan tekan Enter. Nomor yang dikenal 

seharusnya nampak. Tujuan kita adalah untuk menemukan mengapa, dan juga 

untuk menunjukkan median dari beberapa segi tiga yang sama panjang. Tutup 

kotak tersebut. 

7. Segitiga diberi warna berbeda, agar mudah diamati dengan melakukan klik 

Edit > Highlight > Line attributes. Ketik titik AB, BC, CA kedalam kotak 

lines, 2 ke dalam kotak thickness, dan klik apply. Tutup kotak tersebut. 

8. Klik Line > Segments, ketikan titik AGBF kedalam kotak, dan tekan Enter. 

 

 

   Apakah dari ke-empat sisi AGBF terlihat sama? Panjang ke-empat sisi AGBF 

tidak sama. Ubah klik pada mode  Drag vertices dan gunakan tombol kiri untuk 

mengerakkan puncak dari segi tiga ABC di sekitar layar – tidakkah jawabanmu 

berubah? Ya berubah, tetapi panjang garis AG = FB dan panjang garis GB = 
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AF. Dapatkah kamu membuktikan tanggapanmu? Dengan menggunakan 

langkah No.5  ( Measure ), untuk mencari panjang dari keempat sisi tersebut. 

9. Gambar garis BH dan HC. Seperti Apa segiempat BHCF?  Seperti jajar 

genjang. Bagaimana Anda mengetahui? Karena panjang kedua sisi yang 

berhadapan sama besar, yaitu pajang garis FB = CH dan panjang garis FC 

= BH dan keempat sisinya tidak sama panjang. 

10. Terlihat FH adalah sejajar ke GB, dan FG adalah sejajar ke HB. Berikan bukti 

bahwa itu benar. Dengan menggunakan langkah No.5 ( Measure ), dengan 

mencari <GFH, <GBH, <FGB dan <FHB, karena sudut sehadap sama besar 

yaitu <GFB = <GBH dan <FGB = <FHB jadi FH sejajar ke GB dan FG 

sejajar ke HB. Seperti apa segiempat BHGF? Seperti jajar genjang. 

11. Temukan dua bagian garis dalam gambarmu bahwa kamu yakin mempunyai 

panjang yang sama dengan garis AF, tak peduli bagaimana puncak dari ABC 

ditempatkan pada layar. 

 

2 garis  yang mempunyai panjang sama dengan garis AF tak peduli puncak dari 

segitiga ABC ditempatkan  adalah garis FH dan garis GB. 
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12. Temukan dua bagian garis dalam gambarmu bahwa kamu yakin mempunyai 

panjang yang sama dengan garis CF, tak peduli bagaimana puncak dari ABC 

ditempatkan pada layar. 

 2 garis yang mempunyai panjang sama dengan garis CF tak peduli 

bagaimana puncak dari segitiga ABC digerakkan adalah garis FG dan garis 

HB. 

13.  Bagaimana cara membandingkan panjang dari AF dan FE? Dengan 

mengetahui dahulu panjang dari garis AF dan  FE. Di dapat bahwa 

perbandibangan AF dan FE adalah 2 : 1. ( klik Measure ) atau ( klik Point / 

On segmen ‘koordinat’ ) 

14.  Bagaimana cara membandingkan panjang dari CF dan FD? Dengan 

mengetahui dahulu panjang dari garis CF dan  FD. Di dapat bahwa 

perbandibangan AF dan FD adalah 2 : 1. ( klik Measure ) atau ( klik Point / 

On segmen ’koordinat’  ) 

15. Apa yang akan terjadi jika nilai titik tengah dari B ke CA sekarang digambar? 

Bagaimana anda mengetahui? Dengan klik Point / On Segmen, dari sana  kita 

dapat menarik garis dari titik F ke titik I ( titik tengah dari garis AC ) dengan 

menggunakan Toolbar / Segmen, ternyata titik I segaris dengan BF . 

16. Titik F disebut pusat luasan (titik berat) dari segi tiga ABC. Ringkaslah dalam 

beberapa kalimat apa yang sudah kamu pelajari dari hal ini! 

RINGKASAN : 

# Mencari titik F ( pusat luasan ) bisa dengan cara mencari  2 titik tengah 

baik dari   garis AB, BC atau CA. 

# Segiempat AGBF di dapat dengan cara menarik garis dari titik F melalui 

titik D  ke titik G dengan catatan panjang garis FD = DG, dan di dapat 

segiempat AGBF seperti jajar genjang..  

# Segiempat BHCF di dapat dengan cara menarik garis dari titik F melalui 

titik E  ke titik H dengan catatan panjang garis FE = EG, dan di dapat 

segiempat BHCF seperti jajar genjang. 
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# Lihat Segiempat BHGF, garis FH sejajar ke GB, dan garis FG sejajar ke 

HB. Pembuktiannya bisa menggunakan cara mencari sudut dari  <GFH, 

<GBH, <FGB dan  <FHB, diketahui bahwa sudut sehadap mempunyai besar 

sudut yang sama besar yaitu <GFH = <GBH dan <FGB = <FHB. 

# Titik tengah AC ternyata dapat dicari dengan cara menarik  garis lurus dari 

garis BF.   

 

3.2.3   Titik Tengah Segiempat 

1. Bukalah program Wingeom-2dim. 

2. Untuk memulai, klik Unit > Random > Convex polygon, ketik 4 dalam boks 

edit kemudian tekan Enter. Sebuah Segiempat ABCD sembarang akan 

ditampilkan pada layar. 

 

3. Tanda titik tengah pada keempat sisinya: Klik Point > on Segment, ketiklah 

AB, BC, CD, DA, dalam kotak segment, akan nampak 0.5 telah disiapkan 

dalam kotak coordinate dan klik mark. Keempat titik tengah E, F, G dan H, 

akan nampak pada AB, BC, CD, dan DA secara berturut-turut. Tutuplah kotak 

dialog itu. 

4. Menyambungkan titik tengah untuk membentuk sebuah segiempat baru: Klik 

Line > Segements, ketik EFGHE, pada kotak edit, dan tekan enter.(Kotak 

dialog ini menerima EFGH sebagai sebuah singkatan untuk dari sisi-sisi EF, 

FG, GH, HE. Cara singkatnya akan dikerjakan pada langkah ke-2). Sekarang, 

segiempat EFGH akan ditampilkan pada layar. 
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5. Karena dipilih secara random maka segiempat ABCD tidak memiliki sifat-

sifat khusus. Namun demikian, segiempat EFGH hasil dari titik tengahnya 

adalah segiempat yang khusus. Untuk melihat kekhususannya, gunakan 

measurements EF, FG, GH, HE. (Measure,  hanya dapat digunakan pada saat 

itu) Kekhususan seperti apakan Segiempat EFGH itu? 

 

6. Jika segiempat ABCD memiliki sifat khusus, maka segiempat EFGH hasil 

dari titik tengahnya mungkin memiliki sifat khusus lainnya. Jika kamu 

arahkan mouse pada Btns > Drag vertices dan menggeser sudut dari ABCD 

pada sekitar layar kerja, kamu dapat memberikan sifat khusus dari ABCD dan 

lihat apa yang terjadi pada EFGH sebagai hasilnya. Atau, dengan pendekatan 

sementara, kamu dapat memulai dengan sebuah ABCD yang memiliki sifat 

khusus dan buatlah segiempat EFGH hasil dari titik tengahnya. Sebagai 

contoh, klik Units > Random > Kite untuk memperoleh sebuah layang-layang 

atau klik Units > Random > Trapezoid untuk memperoleh sebuah trapesium, 

keduanya ditampilkan secara random. 
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Dengan pendekatanmu, kamu mungkin ingin membuat pengukuran 

tambahan sebagai jawaban dari masing-masing pertanyaan berikut: 

Jika ABCD adalah persegi panjang, maka EFGH adalah belah ketupat 

Jika IJKL adalah layang-layang, maka MNOP adalah persegi panjang 

Jika QRST adalah belah ketupat, maka UVWX adalah persegi panjang 
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Jika ABCD adalah trapesium, maka EFGH adalah belah ketupat 

Jika IJKL adalah jajargenjang, maka MNOP adalah jajargenjang 

Jika QRST adalah persegi, maka UVWX adalah persegi 

 

Jika ABCD adalah segiempat tidak beraturan, maka EFGH adalah 

jajargenjang 

 

7. Sebaliknya, dapat ditanyakan bagaimanakah seharusnya sifat segiempat 

ABCD, yang menghasilkan suatu segiempat EFGH. Lengkapilah masing-

masing berikut: 

Jika EFGH adalah persegi panjang, maka ABCD harus belah ketupat atau 

layang-layang 
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Jika EFGH adalah belah ketupat, maka ABCD harus persegi panjang atau 

trapesium 

Jika EFGH adalah jajargenjang, maka ABCD harus jajargenjang dan 

segiempat tak beraturan. 

Jika EFGH adalah persegi, maka ABCD harus persegi 

(Jawaban diatas berdasarkan hasil pengamatan pada langkah 5) 

8. Diagonal-diagonal ABCD berperan penting dalam pola dari contoh-contoh 

sebelumnya. Apakah peran pentingnya itu? 

Pada bangun datar segiempat yang mempunyai sisi-sisi saling sejajar dan 

sama panjang, diagonal-diagonalnya akan membagi dua sama panjang 

masing-masing sisi pada bangun datar hasil dari midpointnya. Bangun 

datar tersebut diantaranya adalah persegi panjang, belah ketupat, persegi 

dan jajargenjang.  

 

Selain bagun datar segiempat tersebut kecuali segiempat tak beraturan, 

hanya salah satu diagonalnya saja yang membagi dua sama panjang pada 

dua sisi yang saling berhadapan pada bangun datar hasil dari 

midpointnya.  
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9. Efek yang berguna: Gambar diagonal AC dan BD (gunakan tombol kiri 

mouse, atau cara lain, klik Line > Segments), dan kemudian meng-highlight. 

Caranya, klik Edit > Highlihgts > Line attributes, ketiklah AC, BD pada 

kotak lines, 2 pada kotak thickness dan klik apply. Tutup kotak dialog ini, 

kemudian geser masing-masing sudut ABCD dan pelajari hubungan antara 

EFGH dan diagonal-diagonal AC  dan BD . 

10. Sebuah pendekatan yang mungkin untuk pertanyaan pertama pada nomor 6: 

Mulai dengan sebuah persegi panjang dan rubahlah labelnya menjadi EFGH 

(pertama arahkan dan klik mouse pada Btns > Text, kemudian klik kanan 

masing-masing label untuk merubahnya). Arahkan mouse kembali pada Btns 

> Segments dan tandailah  titik A diluar persegi panjang di sekitar E. 

Kemudian buatlah segiempat ABCD sedemikian sehingga EFGH merupakan 

titik tengah segiempatnya: Pertama, hubungkan A ke E, kemudian gunakan 

Point > on Segments  untuk memperpanjang AE  ke B sedemikian sehingga E 

adalah titik tengah AB . Kemudian hubungkan B ke F dan begitu seterusnya. 

Ketika kamu selesai, temukan sifat khusus dari ABCD, tidak masalah dimana 

A diletakkan dimanapun. 

 

Kesimpulan: 

Pengerjaan soal pada langkah 6 dengan cara pada langkah 9, didapatkan 

hasil sebagai berikut: 
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Hal ini memberikan tambahan jawaban bahwa segiempat tak beraturan 

dapat memberikan hasil bangun datar tertentu pada titik-tengahnya 

 

3.2.4  Teorema Pythagoras 

1. Bukalah program Wingeom-2dim. 

2. Untuk memulainya, klik Unit > Random > Right triangle.  Sebuah segitiga 

siku-siku sembarang akan muncul dilayar. 

3. Klik Units > Polygon >Attach > Reguler, Pastikan angka 4 didalam sides 

box, ketik BA, AC, CB didalam kotak sisi, dan klik attach. Persegi BADE, 

ACFG, dan CBHI harus terletak diluar segitiga ABC. Karena program ini 
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pengerjaan pemberian label berlawanan arah jarum jam, kamu harus teliti 

jangan sampai terbalik dalam penulisan BA dengan AB dalam mengetik. 

4. Klik Measure. Ketik BADE dan tekan Enter untuk melihat luas persegi 

BADE. Ketik ACFG+CBHI dan tekan enter untuk melihat jumlah luas persegi 

ACFG dan CBHI. Perhatikan hasilnya. Tutup kotak dialog. 

  

 

 

5. Klik Edit >Randomize. Sebuah segitiga siku-siku sembarang akan muncul 

dilayar dengan disertai segi empat. Perhatikan bahwa perhitungan tetap sama.. 

6. Untuk mulai lagi dari awal, klik File >New (klik no jika tidak akan 

menyimpan file yang telah dibuat). Kemudian klik Units > Random > 

Triangle (perhatikan: bukan sebuah segitiga siku-siku). Sebuah segitiga 
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sembarang akan muncul dilayar. Lakukan langkah 2 dan 3. Dua perhitungan 

yang mungkin tidak sama. Kembali ke dialog Measure dan bertanya untuk 

ukuran dari sudut BCA. (Ingat untuk mengetik < BCA). Tutup dialog box. 

  

 

 

7. Agar dapat menggunakan mouse untuk mengeser satu persatu titik sudut, klik 

Btns >Drag vertices.  

8. Ambil sembarang titik sudut dari segitiga ABC, klik kiri tahan, dan geser titik 

sudut yang dipilih keposisi yang baru. Perhatikan bahwa label sudut berubah 

warna, untuk menandakan kamu telah mengubah titik sudut. Pengeseran titik 

sudut kesekitar dalam diagram acak. Perhatikan bahwa perhitungan yang 

ditampilkan berubah ketika diagram tersebut dijalankan. Coba untuk 

mengubah segitiga ABC sehingga ukuran luas BADE dan ACFG+CBHI sama 

besar, perhatikan apa yang terjadi pada ukuran segitiga BCA. 
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9. Jika kamu mencoba menggeser salah satu titik sudut selain A, B, atau C, kamu 

akan mengetahui jumlah keseluruhan. Apakah kamu dapat memperkirakan 

bahwa ini dapat terjadi? 

Karena pada awalnya kita hanya membuat segitiga ABC sehingga titik-

titik sudut yang lain merupakan satu kesatuan yang tidak dapat diubah. 

10. Sesuatu yang menarik: Ulangi lagi langkah 1, 2, dan 3 tetapi gantilah persegi 

yang diluar segitiga ABC dengan segi lima beraturan. Untuk melakukan ini, 

taruh angka 5 kedalam sides box seperti pada langkah 2. Pada langkah 3 

sertakan luas dari segilima dengan mengetik 5 huruf yang membentuk segi 

lima tersebut, sebagai contoh BADEF. Apakah kamu memperhatikan sesuatu 

yang tidak asing dalam pangukuran? 
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Dari percobaan 1 dan 3 dapat dilihat bahwa jumlah luas segilima BCLKJ dan   

ACGHT sama dengan luas segilima ABFED. 

11. Pada soal yang sebelumnya dapat diulangi dengan segi banyak lainnya.disini 

ada suatu explorasi yang sedikit berbeda.Mulai dengan segitiga siku-siku 

senbarang yang baru dan menandai titik tengah dari sisinya: klik Point >on 

Segment. Ketik  AC,CB,BA didalam segments box,periksa bahwa 

0,5menunjukkan coordinate box dan klik mark. Tutup dialog box. 

12. Klik Circle >Radius-Center untuk menggambar beberapa setengah lingkaran. 

Ini harus digambar satu persatu. Ketik D ke dalam center box, dan C ke dalam 

arc starting at box. Klik ending at button, ketik A pada adjacent edit box, dan 

klik draw.Sebuah setengah lingkaran akan terletak di luar segitiga ABC. 

Untuk melihat dua busur lingkaran lainnya, gunakan E dan F sebagai pusat, 

dan B dan A sebagai puncak, berturut-turut. Perhatikan bahwa itu 
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membedakan busur lingkaran yang terakhir yang di mulai dari puncak, sebab 

program ini menggeser ke arah yang berlawanan dengan arah jarum jam. 

13. Pada suatu waktu kamu dapat membatalkan langkah terakhir dengan mengklik 

undo. 

14. Untuk mengukur luas setengah lingkaran, kamu harus menggunakan rumus 

umum ½ πr
2
. Klik Measure untuk membuka dialog, kemudian ketik 0.5 

[pi]DC^2 dan tekan enter untuk melihat luas setengah lingkaran yang pertama. 

(Tanda kurung siku di atas perlu, karena di sini tidak dijelaskan pada program 

untuk mencari bagian yang dinamakan PI). Kamu dapat menekan F1 sebagai 

pengganti [pi]. Kamu juga dapat mengetik [pie] (DC) untuk melihat luas 

daerahnya. Sekarang ketik rumus untuk luas daerah dua setengah lingkaran 

lainnya. Apakah jawabannya berhubungan dengan perkiraanmu? 

 

       

 

15. Dalil pythagorean yang ditetapkan, persegi dalam hipotenuse dengan segitiga 

siku-siku adalah sama untuk jumlah dari kaki-kaki perseginya. Kemukakan 
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beberapa versi umum dari dalil ini, dengan mempertimbangkan contoh yang 

baru saja kamu lihat. 

Jawab: 

• Persegi dapat dibentuk dari dua segitiga siku-siku yang sama 

besar 

• Jumlah sudut persegi (dalam derajat) yang dibentuk oleh dua 

segitiga siku-siku yang sama besar adalah 180
0
. 

 

 

3.3  Pembelajaran Lingkaran dan Irisan Kerucut 

 

3.3.1  Titik Pusat Lingkaran Luar Segitiga 

1. Bukalah program Wingeom-2dim. 

Bagian I 

2. Untuk memulai membuat segitiga sembarang dengan mengklik Unit > 

Random > Triangle. 

3. Gambar dua garis tegak lurus yaitu AB  dan BC : cara yang paling mudah 

untuk menghasilkan  dua garis tegak lurus dengan mengklik Line > 

Perpendiculars > Perp bisectors, ketik AB, BC kedalam kotak lalu tekan 

enter. Layar akan mengatur untuk menampilkan DE dan FG , dimana D dan F 

sebagai titik tengah. 

4. Namakan titik potong dari dua sektor. Ada dua cara untuk membuatnya. Jika 

mouse dalam model Btns > Segments, hanya titik pada titik potong dan klik 

pada kanan bawah.  Label H akan ditampilkan. (Cara lain untuk menampilkan 

titik potong yaitu dengan menggunakan Point > Intersection > Line-line. Cara 

ini lebih baik untuk melihat titik potong dengan bagus. 
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5. Menandai titik tengah CA : klik Point > on Segment, ketik CA pada kotak 

segmen, peringatan bahwa koordinat 0,5 selalu ditampilkan dalam kotak 

koordinat dan klik Mark. Label I akan ditampilkan pada titik tengah. 

6. Hubungkan H dan I. (ada dua cara untuk melakukanya).  
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7. Buka kotak Measure lalu ketik HC, HA , ∠  HIA, pada waktu yang sama. 

Tutup kotak dialog. Peringatan bahwa tampilan konfirmasi ukuran-ukuran 

sebuah teorema tentang dua garis tegak lurus dari segitiga, Apa teoremanya? 

Karena °=∠ 90HIA   maka menggunakan Teorema Phytagoras. 

8. Karena ABC adalah segitiga sembarang , maka titik puncaknya  dapat ditarik 

disekitar layar,dan ketika berhenti maka ukuranya akan berubah. Letakkan 

mouse di Btns >Drag verticles, kemudian gunakan tekhnik penarikan kiri-

bawah pada A, B,  dan C untuk melihat tampilan ukuran, selanjutnya untuk 

mengilustrasikan teorema. (bagian lain dari gambar tidak bisa ditarik 

mengelilingi dengan memindahkan keseluruhan dari gambar). 

 

Bagian II   

9. Klik Edit > Delete > Point,ketik E F G I ke dalam kotak  lalu tekan Enter. Ini 

memindahkan kembali dua garis lebih baik dari pada, memindahkan 4 titik 

dari gambar. Apakah akan tetap segitiga ABC dan satu dari dua garis 

tegaklurus bernama DH, dimana H disebut keliling pusat dari ABC. Kamu 

dapat menghapus ukuran dari gambar (membuat pengertian dari salah satu  

garis yang tidak panjang ). 

10. Tarik titik C disekitar layar, perhatikan bahwa kontruksi H untuk digeser 

diantara 2 sektor DH, dimana H tidak bisa dipindah. H bebas dari C. 
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11.  Tarik A dan B disekitar layar. Perhatikan bhwa H terpaksa berhenti untuk 

digeser diantara dua sector DH ,salah satu harus bergeser karena AB  

berpindah. 

12. Perhatikan bahwa kadang-kadang pusat keliling H ada didalam 

segitiga,kadang-kadang ada diluar segitiga, tentunya ini tergantung  posisi dari 

3 titik. Cobalah untuk membuktikan tentang fenomena diluar dan didalam dan 

luar ini. Dalam keterangan ketika pusat keliling dari dalam ke luar  (atau luar 

ke dalam), dimana letek perpotongannya? 
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Bagian III 

13. Untuk membuat bagian baru dengan mengklik File > New. Pilih No, lalu 

meminta yang lain Units| Random| Triangle 

14. Cara cepat membuat pusat keliling dari menampilkan ABCadalah dengan 

meminta dari keliling lingkaran. Klik Circle > Circumcircle, perhatikn bahwa 

ABC siap ditampilkan di kotak edit, laku tekan Enter. Lingkaran dengan pusat 

D akan ditampilkan. Karena pada bagian ini kita tidak membicarakan tentang 

lingkaran , maka kita akan menghapusnya dengan cara : klik Edit > Delete > 

Circle,pilih Circle pada daftar kotak lalu klik  tombol Delete. Lingkaran tidak 

ditampilkan hanya meningalkan dibelakang pusat D tutup kotak dialog 

penghapusan. 

 

 

15. Sama seperti pada langkah 10, 11 dan 12, memindahkan puncak ABC sekitar 

layar , mencoba untuk membuat pengertian dari gerakan pusat keliling D. 
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Bagian IV  

16. Sekarang kita fokus pada segitiga sama kaki, yang sejuh ini menjadi dasar. 

Klik Line > Segments,tulis DA, DB, DC dalam kotak lalu tekan Enter. 

17. Klik Measure dan meminta ( bersamaan) untuk .,, DBCDCBDCA ∠∠∠  Tutup 

kotak dialog dan geser puncak  segitiga ABC di sekitar layar. Perhatikan 

pernyataan kedua dan ketiga tentang sudut, kenapa begitu? Pernyataan 

pertama dan kedua tidak sesuai, apakah CD  adalah sudut bisector? Apakah  

dua dari segitiga sama kaki selalu kongruen satu sama lain? 

Pernyataan kedua dan ketiga memiliki sudut yang sama walaupun salah 

satu titik digeser disekitar layar. Tidak, CD  merupakan bukan sudut 

bisector karena  

DCBDCAdan∠∠ tidak sama besar. Tidak, karena tidak ditemukan dari 

dua atau tiga segitiga yang sama dan sebangun. 
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18. Chek bagian  ini dengan mengklik Other > Autuextend. Klik Point > 

Intersection > Line-line > tulis AB dan CD kedalam kotak dan tekan Enter. 

Titik E menghadap AB  danCD  akan diperpanjang untuk jangkauannya, jika 

perlu (ini adalah alasan untuk mengaktifkan Autoextend). Geser ABC 

disekitar layar, apakah E merupakan titik tengah dari AB ? apakah CE  

tegaklurus AB ? buatlah pengukuran tambahan jika diperlukan. Tidak,karena 

ukuran EBdanAE  tidak sama besar. CE  tidak tegak lurus dengan AB , 

karena BECAECdan∠∠  tidak sama dengan °90  

19. Sebagai efek ekstra kamu bisa mewarnai segitiga tersebut. Klik Edit > 

Highlights > Fill regions , ketik DAB di dalam kotak dan Klik Fill, sebelum 

mewarnai segitiga DBC dan DCA, buka Color palette dan klik cell baru untuk 

mengubah warna, jika kamu berubah pikiran  kamu dapat Delete one item dari 

Fill inventory. Tekan Ecape untuk menutup dalog. Jika label alphabetic ada 

dalam warna ,kamu bias menekan Ctrl + L untuk mematikan label. Atau kamu 

bisa pakai cara Btns > Text dan memindah label dalam lokasi baru.   
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3.3.2 Parabola 

 

1. Bukalah program Wingeom-2dim. 

2. Untuk memulai, klik Unit >Segment, kemudian klik ok. Muncul garis AB. 

3. Klik  Point > Coordinates. Ketik koordinat x = 0.5 dan koordinat y = 0.3 ke 

dalam kotak. (Kita dapat menggunakan tombol Tab untuk menggeser dari 

kotak satu ke kotak yang lain, atau dengan klik kiri. Dengan menekan Tab 

akan selalu menampilkan teks yang akan dipilih). Klik Mark untuk membuat 

titik C pada koordinat. Kita dapat menekan Escape untuk menutup kotak 

dialog, yang mana akan memindahkan titik koordinat. 

4. Kita dapat membatalkan kembali langkah terakhir dengan Edit > Undo (atau 

dengan menekan control +Z). 

5. Klik  Point > on Segment. Kita akan membuat titik yang dapat bergerak pada 

garis AB. Untuk membuatnya, Ketik # (yang mana membantu banyaknya 

suatu variabel) ke dalam kotak edit, periksa kotak segment yang 

memperlihatkan AB, kemudian klik Mark. Titik D muncul pada garis AB. 
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6. Kita akan menghubungkan C ke D, klik Line > Segments. Ketik CD (huruf 

kecil tidak masalah) dan tekan Enter (atau klik OK). Muncul garis CD. 

7. Kita akan melukis garis tegak lurus membagi dua garis yg kita buat. Klik Line 

> Perpendiculars > Perp bisectors. Ketik CD ke dalam kotak edit dan tekan 

Enter (atau klik OK). Muncul garis EF dengan E titik tengah garis CD. 

8. Kita akan melukis garis yang tegak lurus garis AB dan memotong D. Klik 

Line > Perpendiculars > General. Ketik AB ke dalam kotak perpendicular to 

dan D ke dalam kotak through point dan klik draw. Muncul garis DG. Bingkai 

yang terlihat mungkin akan berubah posisi karena titik baru tersebut. Tutup 

kotak dialog. 

 

 

9. Kita akan memberi nama titik pada dua garis tegak lurus yang saling 

berpotongan. Ada dua cara yang dapat dilakukan. Jika menggunakan mouse 

cara Btns > Segments, klik pada titik potong dengan klik kanan. Muncul H. 

(Cara lain : klik Point > Intersection > Line-line. Ketik garis dengan nama 

DG dan EF ke dalam kotak dan klik Mark. H muncul. Kita dapat menekan 

Escape untuk menutup kotak dialog). 

10. Klik Animate > # Slider. Ini membuat sebuah control Scrollbar yang dapat 

mengubah-ubah posisi titik D pada garis AB. Variasi posisi dilukiskan dengan 
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satu koordinat #, yang sudah dibuat sehingga 0 sesuai dengan posisi A dan 1 

sesuai dengan posisi B. Kita dapat mengubah posisi D dengan mengetik nilai 

baru untuk # dan tekan Enter, atau dengan menggunakan klik kiri dan tarik 

Scroll, atau dengan klik panah ke kiri dan ke kanan. Cobalah! Ketika gambar 

bereaksi, posisi titik H berubah. Pandanglah mengikuti lintasannya. Jangan 

meng-klik dua tombol set kecuali kamu tahu apa guna tombol itu. 

 

 

 

11. Kita dapat juga meletakkan scrollbar pada autopilot dengan meng-klik tombol 

reverse. Sebagai peringatan bahwa kotak dialog hilang, dan muncul judul baru 

diatas gambar window : untuk menghentikan animasi kamu dapat menekan Q.  

12. Untuk melihat lintasan parabola H, buka Animasi > Tracing dialog dan klik 

New. Ketik H ke dalam kotak pen on, periksa bahwa tombol control untuk # 
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terpilih, tinggalkan yang lainnya dan tekan Enter untuk mengkonfirmasikan 

pilihanmu. Kurva parabola harus tampak dengan konstruksi kita diatasnya 

 

 

 

Pertanyaan: 

Dengan pengecualian titik H, semua titik pada perpotongan garis tegak 

lurus membagi dua garis CD mendekati garis AB(direktrik) dari pada titik 

C(titik fokus). Jelaskan mengapa?  

Gambar tersebut memperlihatkan bahwa garis tegak lurus membagi dua 

garis CD merupakan garis singgung parabola(di H). Jelaskan mengapa? 

 

Jawab: 

Karena garis tersebut memotong tegak lurus garis CD, sedangkan garis 

AB merupakan lintasan titik D, sehingga garis tersebut tidak mendekati titik C 

maupun titik D, tetapi mendekati lintasan titik D. 
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Karena ada satu titik pada garis tersebut, yaitu titik H, yang membuat 

lintasan parabola(titik potong antara garis EF dan parabola), sehingga garis 

tegak lurus CD tersebut selalu menyinggung parabola jika digerakkan.   

 

 

 

3.4   Latihan 

 

1. Buatlah file wg.2 yang dapat digunakan untuk pembelajaran dengan topik 

“simetri putar pada persegi”, dengan memanfaatkan fasilitas animasi, seperti 

pada tampilan berikut. 
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2. Buatlah file wg.2 yang dapat digunakan untuk pembelajaran “sifat-sifat 

belahketupat”, dengan fasilitas animasi, seperti pada tampilan berikut. 

 

 

3. Buatlah file wg.2 yang dapat digunakan untuk pembelajaran “dilatasi”, dengan 

memanfaatkan fasilitas animasi, seperti pada tampilan berikut. 
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4. Buatlah file wg.2 yang dapat digunakan untuk pembelajaran dengan topik 

“garis singgung lingkaran”, seperti pada tampilan berikut. 

 

5. Buatlah file wg.2 yang dapat digunakan untuk pembelajaran dengan topik 

“fungsi 1/x”, dengan memanfaatkan fasilitas animasi, seperti pada tampilan 

berikut. 

 


